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1 RT-Druid and Erika Enterprise tutorial for dsPIC
(R) DSC

This small tutorial describes a set of steps needed to compile a simple application that
shows the main features of Erika Enterprise and RT-Druid for the dsPIC (R) DSC platform.
This tutorial has been tested on a FLEX board produced by Evidence and Embedded
Solutions and on a Microchip Explorer 16 development board from Microchip.
We presume that the reader is familiar with the MPLAB IDE debug environment

provided by Microchip.



2 Note for Windows XP and Windows Vista
users

If you are using Windows, and especially if you are using Windows Vista, please look
carefully at the following warnings:

Warning: The Evidence package installation path should NOT contain directory
name with spaces. For e.g. use c:/Evidence/Evidence

Warning: The Scilab package installation path should NOT contain directory
name with spaces. For e.g. use c:/Evidence/scilab-4.1.2

Warning: If using Vista, be aware that directories like c:/Programmi,
c:/Users/Documenti are not REAL directories but are aliases. DO NOT USE THEM.
Put your RT-Druid workspace under c:/Users/yourusername/workspace.

Warning: Please install cygwin into its default directory, c:/cygwin.

Warning: Also if from the Windows Vista Explorer your Microchip compiler
seems to be installed under c: /Programmi/Microchip/. . ., please remember to specify
the REAL pathname. In particular, c:/Programmi DOES NOT EXISTS, whereas

the correct name is c:/Program Files.
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This

Installing Erika Enterprise and RT-Druid on
Microsoft Windows

chapter will guide the developer on the installation procedure of Erika Enterprise

and RT-Druid for the dsPIC (R) DSC platform.
The installation of Erika Enterprise and RT-Druid is composed of following packages:

The Eclipse development environment, which is used by RT-Druid to provide the
basic development environment for Erika Enterprise applications.

The Eclipse environment is based on the Java platform, so that a working Java
Runtime Environment must be present for using RT-Druid.

The RT-Druid plugins, which provide the code generation for Erika Enterprise for
Eclipse.

The Erika Enterprise source code.
The Microchip MPLAB IDE.

The Microchip C30 Compiler.

A version of the Microchip C30 compiler recompiled from the GCC sources, which
enables basic C language compilation without the need to buy the full fledged
Microchip C30 Compiler.

A set of examples for the dsPIC (R) DSC Platform, which can be used to compile
a first set of running examples for the Evidence/Embedded Solutions FLEX board,
the Microchip Explorer 16 board, and others. These applications are organized in
“templates”, available at project creation.

A subset of the Cygwin environment [1], including a set of utilities like make, gawk,
and few others, which are used during the compilation process of an Erika Enterprise
application.

To install the software, execute the following steps:

1.

Install your favourite Java runtime environment, which is needed to run RT-Druid:;
as RT-Druid is a plugin of the Eclipse editor, which requires Java to be executed.

Install the latest version of the Microchip MPLAB IDE; you can use the default
install directory. At the end of the install process, accept the system reboot.



3 Installing Erika Enterprise and RT-Druid on Microsoft Windows

3. Install the Microchip C30 Compiler, available from the Microchip web site. Even
in this case, you can use the default install directory. When it is asked to change
the default environment, please do accept.

4. Run the Erika Enterprise and RT-Druid installer.

5. The installer will prompt a list of packages which can be installed. Select all the
packages you wish to install and continue the installation procedure (see Figure
3.1).

147 Erika Ertterprise for dsPIC D3C Setup [= | = /=]

Choose Components -
Choose which features of Erika Enterprise for dsPIC DSC you want to install, (

Check the components you want ko install and uncheck the components you dan't want ko
install, Click Install to skart the installakion,

Select components ko install: Cygwin Description

Erika Enterprise

Space required: 287.1MB

< Back ][ Install ] [ Cancel

Figure 3.1: This screenshot shows the dialog box with the available install packages.

Note: The Erika Enterprise install package provides a version of the Microchip C30
compiler recompiled from the GCC sources made available by Microchip. Although
that compiler is able to compile Erika Enterprise applications, it does not include
Microchip include files and libraries which are distributed with the Microchip package
only.

6. The installer will ask for a destination directory. If possible, please use c:/Evidence/Evidence
(see Figure 3.2).

7. At this point, please check the firstline of the file evidencedir\bin\mymake_cygwin.bat
(where evidencedir is the directory you chose during the installation). For exam-
ple, if Cygwin is installed inside C:\cygwin, then the first line of the file should
look like the following one:

@set EE_BASH_PATH=C:\cygwin\bin\bash
...that is, the line contains the correct path to the bash.exe file in your Cygwin

installation. If you accepted the default settings, the correct pathname should be
C:\cygwin\bin\bash as specified in the example before.



3 Installing Erika Enterprise and RT-Druid on Microsoft Windows

147 Erika Ertterprise for dsPIC D3C Setup [= | = /=]
Choose Install Location -
Choose the Folder in which to install Erika Enterprise for dsPIC DS, (‘J

Setup willinstall Erika Enterprise For dsPIC DSC in the Follawing Folder. Tainstall in a different
Folder, dick Browse and select another Folder. Click Install to start the installation.

Destination Folder

C:\Evidence\Evidence Browse. ..

Space required: 110.8MB
Space available: 5 4GB

< Back ][ Install ] [ Cancel

Figure 3.2: This screenshot shows the preferred destination dir for installing Erika
Enterprise.

Note: We ask to perform this check because it seems that on some Windows ma-
chines the Cygwin installer does not correctly set the registry keys used by the Erika
Enterprise installer.

The rest of this tutorial assumes that the Microchip MPLAB IDE is installed within
the C:\Programmi\Microchip directory and that, consequently, the GNU Assembler
for dsPIC (R) DSC is installed within C:\Programmi\Microchip\MPLAB ASM30 Suite\bin.
Please note that these values may be different from the settings you have chosen on your
machine. Please also read the chapter with the Windows Vista recommendations.



4 First RT-Druid startup and configuration

After all the required packages have been installed, you are ready to start RT-Druid for
the first time.
Please follow the next steps:

1. As the first step, run the Eclipse IDE from the Evidence menu inside the Start
menu of your Windows machine, choosing Start/Programs/Evidence/RT-Druid.

2. A dialog box will appear, prompting to choose the right workspace (see Figure
4.1). Leave the default workpackage directory as it is, and proceed by pressing
(LOK”.

= Workspace Launcher (==
Select a workspace

Eclipse Platform stores your prajects in 3 fold
Chaase a workspace folde ¢ this session.

Workspace: |5 - Brawise...
[] Use this as the default and do not ask again

Figure 4.1: This screenshot shows the dialog box for the choice of the current workspace
directory.

Warning: The workspace pathname MUST NOT contain any blank space, other-
wise Erika Enterprise and RT-Druid may not work properly.

Note: If you are using Windows Vista, then the workspace directory
c:/Users/<username>/workspace works.

3. The Eclipse Welcome screen appears, like in Figure 4.2.

4. Before being able to correctly build your application, you should set the path to
the Microchip C30 compiler and the MPLAB ASM30 assembler programs. For
doing so, please go to the “Preference” menu, as shown in Figure 4.3, and find
the “RT-Druid/Oil/PIC30 Configurator” form as depicted in Figure 4.4. The first



4 First RT-Druid startup and configuration

= C/C++ - Eclipse Platform ===

File Edit Refactor Wavigats Search Run Project Window Help

E-e)

@

Workbench
Go to the workbench

Figure 4.2: The Eclipse Welcome screen.

textbox, labeled Gecc path, refers to the installation directory of the Microchip C30
compiler. The second textbox, labeled Asm path, refers to the installation directory
of the ASM30 assembler provided with the MPLAB IDE.

Warning: The install directories specified in the two textboxes of Figure 4.4 does
not include the bin directory!

That is, c:\Programmi\Microchip\MPLAB C30 is correct, whereas
c:\Programmi\Microchip\MPLAB C30\bin is not.

Warning: The install directory of the assembler refers to the assembler provided
with MPLAB IDE and not the assembler provided with the C30 compiler. The reason
is that the directory is used to call the assembler and also to copy the crt0.s file,
which has a different position in the two assembler distributions made by Microchip.

Warning: If you are using a Student Editon of the Microchip C30 compiler with an
expired license, please check the “Use EE gcc to resolve dependencies” checkbox
in Figure 4.4.
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4 First RT-Druid startup and configuration

S C/Coe - Eclipse Pltform SEEs
file Edit Refactor Naigate Search Run Project (Window)
= e

(- project Bplorer £3 =

& Problems £ 22 Tasks| B Consale | [ Properties

20 @E®

Oitems selected

Figure 4.3: Go to the “Preference” menu.

= Preferences =

|
< B

type filter text. PIC30

General
CCer Gec path eAProgram Files\Micrachip\MPLAB C30
Hel

P fsm path c\Program Files\Micrachip\MPLAB ASM30 Suite

Install/Update
Rt-Druid Use EE gee to resalve dependecies [0
Gil Use EE gec to compile i}

Erika Enterprise
PIC30

Fun/Debug

Tasks

Team

Usage Data Collectar

Restore Defaults Apply
@

Figure 4.4: Select paths for compiler and assembler.

5. Before creating and building your application, please deselect the “Build Auto-
matically” flag inside the “Project” menu, as shown in Figure 4.5.
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4 First RT-Druid startup and configuration

" iB-0-Qr (®B - i

(2 ProjectErplore 53, =0 i Buid Al Cti+B

5 = Build Canfiguration: 3
%@ ol

Build Project o ot iz

Build Working Set »
Clean

Build Automatically

Make Target »

Properties

2 Problems 520 Tasks| ) Console| I3 Properties ®° -0
Ditems
Deseription = Resource Path Location Type

o® Ditems selected [ale B®$|

Figure 4.5: Deselect the “Build Automatically” flag in the “Project” menu.
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5 Compiling your first Erika Enterprise demo for
dsPIC (R) DSC

You are now ready to compile your first Erika Enterprise demo. Please execute the

following steps:

1. Please select “New Project”, then “RT-Druid Oil and c¢/c++ Project” from the
“File menu”, as in Figure 5.1.

= C/C++ - Eclipse Platfarm = |5 =
Edit Refactor Mavigate Search Run  Project WWindow Help
= il 1
Hew Aftashift+h > | B CProject - e A : o [T
OpenFile.. B CoxProject ‘
e ol | RT-Druid Oil snd GZC-++ Project =5 (% o @ ] = O
Close Al e o el =
— Cipes | B Gomverttos GG Make Project & outline s nat available,
s A% Source Falder
Save Al Chilsshiftss | & Folder
o & Source File
K Header File
A [% File from Template
Renarne.. 2 |G chs
&1 Refresh Fs
Convert Line Delimiters To il 20 [ S
| = Print. Ctrlep
Switch Workspace »
Restart
fag  Import.
i Export..
Properties At +Enter
Bt
|[20 Problems &2 - ¥ Tasks| B Console | 2 Praperties| ¢~ =0
10iterns
Description Resource Path Location  Type
ik D items selected Al Ew

Figure 5.1: Select “New project” from the “File” menu.

2. A Dialog box appear. Please select a template for the new project, as in Figure
5.2.

3. Press “Next”.

4. Insert the name of the new project. Please type taskdemo (you can choose other
names of course). Please see Figure 5.3. Press the “Finish” button.
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

= New Project == EE
RT-Druid C/C++ Project

Evidence RT-Druid willcreate and manage this project. The project wil use the ERIKA Enterprise RTOS. The user have to create Altera system libraries manually. &

9] Creste s poject using one of these tmplates

|| Thisis the demo to test the BCC1, BCC2, FP conformance class,
TaskActivate, Schedle, and non preemptive settings.

sse spplication

pplication with demo protatype daughter board

Figure 5.2: Select a template for your project.

= New Projct

= [E e
RT-Druid C/C++ Project p

Project name; | taskdemol

Use default location

CaUsersipjworkspace3ditaskdemo

PTTI T | e

Figure 5.3: Type a name for the new project.

5. We are now ready to build the demo. Right click on the project name in the
Eclipse navigation bar, and choose “Build Project”! (see Figure 5.4).

6. Then, the compilation process starts as depicted in Figure 5.5. Please note the
message that appears when the compilation is successfull.

Note: If the error depicted in Figure 5.6 appears (means that mymake_cygwin.bat is

unable to find a file), then please follow the instructions at the last point of Chapter
3.

L“Build Project” only appears if the “Build Automatically” flag is not selected in the “Project” menu.
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10.

11.

12.

5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

2 C/C++ - taskdema/canf.ail - Eclipse Platfarm =
File Edit Refactor MNavigate Search Run Project Window Help
i o | & - AR AR R TR i O BB a5 [Efercer
(7 Project Explorer £3 = O([8 confusil 52 = O[3 outh 2\ @Mk | = O
| - | ~ =
\ a&le”] 2 =
| P * ERIEA Enterprise - a tiny RTO§ for small microcontrollers T R A
o [ cod,  New » E
Bter 02-2008 Evidence Scl
Open in NewrWindow
t of ERIKL Enterprise.
= Copy Ctrl+C
Paste Carl 4 is free software: you can redistribute it
R Delete Delste | Wnder the terms of the GNU General Publi
~ . . lished by the Free Software Foundation,
Remave from Context Ctri+Alt +Shift + Down exceprion described below) .
More
Rename. {7 e statically or dynamically with other mo
d work based on this code. Thus, the ten
g Import & GNU General Public License cover the whe
4 Exportu,
Build Project eption, the copyright holders of this lil
Clean Project Nk this code with independent modules to |
- rdless of the license terms of these inde)
A\ BerEsh it copy and distribute the resulting executal
Close Project oice, provided that you also meet, for eac
Close Unrelated Prejects le, the terms and conditions of the licen:
pendent module is a module which is not de
Build Configurations » b Library. If you modify this code, you m
Wake thigats , Fo your version of the code, but you are mie
Index » - = | b _
Console| £ Properties #~ =0
Run A v F ! L
Debug As >
Resource Path Location  Type
Profile A5 »
Teamn r
Compare With >
Restore from Local Histery..
Properties AltsErter
o =5 taskderno || 9 =&

Figure 5.4: We are now able to build the project.

At the end of the compiling process you will be able to find a file named ‘pic30.cof
inside the Debug directory inside the project, as shown in Figure 5.7.

You are now ready to import the produced COFF file inside Microchip MPLAB
IDE. To do that, open MPLAB IDE as in Figure 5.8.

Choose “Import...” from the “File” menu, as in Figure 5.9.

A dialog box appear. Please select the pic30.cof file that has been produced by the
compilation process in Eclipse, as shown in Figure 5.10. You can find that file inside
the Eclipse workspace you selected at the beginning in Figure 4.1. In this example,
the file is stored inside the directory c:\Programmi\Evidence\eclipse\workspace\
pic30_oo_mono\Debug.

You have now imported the COFF file inside MPLAB IDE. There is no need
to create a MPLAB IDE Project, because the compilation process is handled by
Eclipse. Figure 5.11 shows the “Disassembly Listing” and the “Program Memory”
window. Please note that MPLAB IDE correctly recognizes the debug symbols of
the source code produced inside Eclipse.

You can now start debugging the demo application using MPLAB IDE.

Figure 5.12 shows the Explorer 16 board running pic30\exploreri6\Devices Demo
demo application, which uses the Explorer 16 onboard devices to monitor and display
the environment temperature.
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

2 C/C++ -taskdema/confall - Eclipse Platfarm

File Edit Refactor Mavigate Search Run
i fod | @
[ Project Bxplorer 2 =0

) Bgle~

2 taskdeme

(= Debug

(g code.c

[© conf.oil

[E=8 EoE =)

5 [EEcc—r

Project Window Help

Br&8-F-6- B b= =R

B O~
[6] confuoil 8 = OBz outh B\ @Mk | T O

i/r -
* ERIRA Enterprise - a tiny RT0§ for swall wicroventrollers [ |G oiimeinetacaibie

* Copyright (€] 200-2008 Evidence Srl
* This file is part of ERIKL Enterprise.

* ERIKR Enterprise is free software: you can redistribute i
9 * and/or modify it under the terms of the GNU Gemeral Public
10 # version 2 as published by the Free Software Foundation,

11 7 (with a special exceprion described below] .

* Linking this code statically or dynamically with other moo

— v

GR|gB -0

) Tasks | Bl Consale &3 Praperties

[2: problems

C-Build [taskderna]

\crp
lcPp
\cep
lcpp

ee_shtdown.c

ee_startos.c

|CPP e chaintas.o
|cPP e=_lockres.c
ICPE ec_ulockres.c

PP es_alzancel.n

ICPE ec_algetbase.c

PP ee_alget.c

PP ee_alsetabs.c

(CPP ee_alsetrel.c

PP e=_altick.c

LR libee.a

LD

|oBaDUMP

\Compilation terminated successTully! L

@l EY

Figure 5.5: The compilation process.

Note: If you get an MPLAB IDE error like the following:

ICDWarn0015: Program

memory has changed since

last program operation?
Continue with Debug operation?

Running Target
ICD0083: Debug:

Unable to enter debug mode.

Please double click this

message for more inf

ormation.

Tasks | Bl consale 2

C-Build [ew]

in
] =R

C:\Programmit Evidenceibin\mymake cygwin.bat all
Impossibile trovare il percorso specificato.

ME-9-° =0

Figure 5.6: An error that s

hows up on some Windows machines.

Please check the

mymake_cygwin.bat file as explained in the last point of Chapter 3.
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

2 C/C++ -faskdema/confall - Eclipse Platfarm = Eo|5e)
File Edit Refactor MNavigate Search Run Project Window Help
lmi o | G - RAEAr R R By i B0 BB P 2 [EEcrcer
(7 Project Explorer £3 = 0|([8] confail & “_ = O[3 outh 2\ @ Mak | = O
| ; B®le T M7 = — e "
= jjc(askdtmv ; o ERIRKA Enterprise - a tiny RTOS for small microcentrollers| | B BUthing 75 et avalEable,
4 (= Debug
4 * Copyright (C) 2002-2008 Evidence 5rl
& frommchp &ls
& obj & * This file is part of ERIKL Enterprise.
[8 ee_picIregsh i
b [ eechye & v ERIKA Enterprise is free softvare: you cen redistribute if
[5) eecfgh S * and/or modify it under the terms of the GNT Gemeral Public
0 libee.a 40| % mersionis aw gubilseted-hysehs Foee Boftmsre Noydation
|5 deps 11 * (with a special exception described below).
[) deps.pre 1z
|| ee_pic3regs.inc 13 * Linking this code statically or dynamically with other mo(_
121 loc_gnu.ld e e g
L makefile L = = =
Bl [2 Problems | Z2 Tasks | Bl console 58 [ Properties &G rBE-r5-7=8
|5 pic3d.map C-Build [taskel
|5 pic30.objdurmp | i
(8 codec cPp
[ confoil (CPP ee_shtdown.c
CPP  ee_startas.c
CPP  ec_chaintas.c
|cPP ee_lockres.c
CPP ee_ulockres.c
CPP  ee_alcancel.c
|CPP ec_algethase.c
CPP e _alget.c
(CPP e _alsetabs.c
CPP  ee_alsetrel.c
CPP  ee_altick.c
IR libee.a
LD [l
o ) taskderno/Debug/pic3l.cof Al BY

Figure 5.7: The output file is ready to be programmed on the target board.

Please make sure that you have entered the debug mode and programmed the
device from the Debugger Mode and not from the Programmer Mode.

Note: If you are using a FLEX board, please remember to set the device correctly
uinder the “Configure / Select device...” menu of MPLABIDE.

The correct settings for the dsPIC on the FLEX Full and the FLEX Light is shown
in Figure 5.13. The correct settings for the PIC18 on the FLEX Full is shown in
Figure 5.14.
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

(21 Files Lwl

] Checksum: 0x039¢

Build_| Version Conuol| Find in Files |

dsPICIFFIZSEMCTD

oabsabP0  denovzc

Figure 5.8: The Microchip MPLAB IDE.

Add Mew File o Project.
Open... Ctrle0
Close

Save Ctrl§
Save As..,

Save Al

Open Warkspace ..
Save Warkspace
Save Warkspace As..
Clnse Warkspace

= Import..
Export..,
Print.. Chil+p
Recent Files »
Recent Workspaces v

Exit

] Checksum: 0x039¢

Build | Version Contral | Find in Fﬂes{

dsPICIIFI2SEMCTL0

0absabIPl  donovzc

Figure 5.9: Choose “Import...”
Eclipse.

from the “File” menu to import the coff file produced in
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

MPLAB IDE
File Edit Visw Project Debugger Programmer Tools Gonfigurs Mindow Help

|Ded|smm [Skw? | Checksum: 0x336

Cercain: | Debug
& £ Uimamo. Tips

L mmehp
Risorse recenti

it

Files L%S&a@eﬁl Desktop

G

P

L] Output
Build | Version Contiol | Find in Files Camputer

HNome file: pic30.cof -

[ i ]
Tholie [AnLosdFies Cheiostsconriatl  w| [ Amula J |

dsPICIFFIZSEMCTD osb sab ) denovac

Figure 5.10: Select the COFF file you want to import.

 Project Debugger Programmer Tools Configure Window Help

| Checksum: Dx750d

|DeW ' ha (Saw?| e 0

#% Taskl: just call the ChristmasTrea 7/

003LE  ASEO4Z bset.b 0x0042,87
180 TASK(Taskl)

00320 scoaz beet b 0x004z, 6
003E2  Z0ZDS0. mov_w 0x2de, 0x0000
00384 BB4AE0 mov_w 0x0000, 0x095¢
1e1: 1

00522 AaKD42 belr.b 0x0042, 65
182 taskl_firedtt;
00394 EC2999 inc.w 0x0298

1za: /% Fizse half of the chrisemas tres 7/
185 Led_blink (0x01) 5
Fles 00336 Z00010  mov.w $0x1,0x0000
00228 O7FECE reall 0x000336
186 led_blink (0x02) -
0038h Z000ZO  mow.w $0xZ,0x0000
0033C  07FFCE reall Dx000336
187 led blink (0x04)
0039E 200040 mov.w $0x4,0%0000
00340 07FFCA  rcall Dx000336

123: #* CONFIGURATION 3 and 4: we pwt an additional Schedule{] hers! */
190 fifdet MYSCHEDULE
191: Sehsdule ()

gendif

#7 Zecond half of the christaas trse =/

135 led_blimk: [0xD&) 5
o03az  zoooeo mov_w $0x8,0x0000
003A4  O7FFCS reall Dx000336

138 led Bliw: (0x10) 5
n0zA6  Z0O100 mov.w $0x10,020000

Q7FRCE reall 0x000336

HAPLAB SIM dsPICIIFI2SEMCTI0  peil osb sab ) denovac 120 MHz

Figure 5.11: Debug symbols are correctly recognized.

19



5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

Figure 5.12: The Explorer 16 board with the running demo program.

Select Device

Device: Device Family:
ds|

SCT—

Microchip Tool Support
Programmers

@ PICSTARTPlus @ MPLABICD 2
@ PROMATEI @ FICkt1
@ MPLAB PM3 @ MWPLAB REALICE

@ PIckit2

Language and Design Tools

@ ASSEMBLER @ COMPILER ) woI
v2.02 v2.02

Debuggers

@ WPLAB SIM @ MPLABICD 2 @ FICkit2

@ MPLAB REALICE

MPLABICE 2000 MPLAB ICE 4000 ICEICD Headers
@ No Module @ No Module @ No Header

[ ok | [ canel | [ Heln

Figure 5.13: Selecting the dsPIC MCU mounted on the FLEX boards.
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5 Compiling your first Erika Enterprise demo for dsPIC (R) DSC

Select Device =

Device, Device Family:

v |ALL -

Microchip Tool Support

Programmers
@ PICSTARTPIUs @ MPLABICD2 () PICKtZ
@ PROMATEI @ PICKI

@ WPLAB PM3 @ MPLAB REALICE

Language and Desigh Tools

@ ASSEMBLER @ COMPILER @ vDI

V280 vzZAD
Debuggers
@ MPLAB SIM @ WPLABICDI () PICKZ
@ MPLAB REALICE

MPLAB IGE 2000 MPLAB IGE 4000 IGENCD Headers
@FCMIBRRD FRZELE @ Mo Header
@FCMIBRRT

ok | [ cancel | [ Help

Figure 5.14: Selecting the PIC18 MCU mounted on the FLEX Full boards.
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6 History

‘ Version ‘ Comment

1.0.0 Initial revision.

1.1.0 Updated with information and screenshots about Erika Enterprise
version 1.4.

1.1.3 Updated with new screenshots about configuration; added warn-
ings about blanks in pathnames.

1.1.4 Added some changes to the install instructions from comments by
Simone Mannori.

1.1.5 Added Cygwin error workaround when the installer can not find
the cygwin registry value.

1.1.6 Typos found when translating the document in italian.

1.1.7 Updated some figures Figure, added a few warning boxes.

1.1.8 Added notes about MPLAB IDE.

1.1.9 Added recommendations for Windows Vista.

1.1.10 Updated screenshots for EE 1.4.3. Erika Enterprise Basic renamed
to Erika Enterprise.

1.1.11 Revised entire document.
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